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Overview of the Message Center 
Message Center is a component of Cerner Millennium used for managing workflow in the 
inpatient or outpatient setting.  It allows you to route information electronically, rather than 
having an unwieldy flow of hard-copy documentation moving around your facility.  The 
Message Center enables you to review or sign results, documents, and prescription 
requests, as well as work with phone and other messages. The Message Center offers 
the following benefits: 

• All messages and notifications that require your attention, review or signature are 
routed to your Inbox and are organized in folders. 

• The operation of taking and distributing phone messages and saving that information 
to the patient's chart is completed electronically. 

• Results can be reviewed, signed, or forwarded to other healthcare providers 
electronically. 

• Your Inbox can be accessed from any computer on your network that has Cerner 
Millennium installed on it. 

• You can customize the items you want displayed in the Message Center by filtering by 
dates, types of results, and so forth. 

Note:  The words Inbox and Message Center both refer to the messaging component of Cerner 
Millennium 2007, and as such, are referred to interchangeably throughout this document. 
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Message Center Basics 

Message Center Interface  

 

Inbox Summary 

The Inbox Summary allows you to access any message or result in the Message Center.  
Message Center notifications are divided into categories or folders; the number adjacent 
to the category name indicates the number of Inbox items in that category that are 
unread.  Tabs at the top of the Summary pane allow you to select which Inbox you would 
like to work with, for example your own Inbox or a pool Inbox. 

Summary Pane/Workspace 

The summary pane lists the individual Inbox items (messages, documents and so forth) 
contained in the folders in the Inbox Summary.  Double-clicking an Inbox item in the 
Summary Pane opens the workspace for that item. 

Message Center users have the ability to sort the view by each column. For example, if 
you select the Assigned column, the view will sort by that column. This is applicable for all 
workspaces of Message Center.  

Note: The ability to use column sorting is available with the 2007.18 Release Update.  

Inbox 
Summary 

Summary 
Pane/Workspace  
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Basic Navigation 
You can move between folders in the Message Center items using one of the following 
methods: 

• Use the Inbox Summary to find and view individual messages. 

• With a message open, click  or  to move to the previous or next message. 

• Click Accept & Next or OK & Next after viewing the message or notification. 

Using the Inbox Summary to Access 
Messages in the Message Center 

The Inbox Summary allows you to access any message or result in the Message Center.  
Message Center notifications are divided into categories or folders; the number adjacent 
to the category name indicates the number of Inbox items in that category that are 
unread.  Tabs at the top of the Summary pane allow you to select which Inbox you would 
like to work with. 

To access messages and other notifications using the Inbox Summary, complete the 
following tasks: 

Click the tab corresponding to the Inbox you would like to work with, for example click the 
Proxies tab to view any Inboxes that you have proxy rights to view. 

If necessary select a specific date range. 

Click the plus (+) sign next to the category to expand it; Click the minus (-) sign next to the 
category to collapse it. Click a folder to display the items in that category. 

Double-click the item or select it and click Open to view the item. 

Searching For Messages in a Specific Date 
Range 

 

Set the date range in the Inbox Summary using one of the following methods: 

• Select a predefined date range from the Display list. 

• Click the ellipsis next to the display list, enter a date range and click OK. 
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Viewing another User's Inbox  

Proxy Capabilities 

Note:  Depending on the way your site is configured, this functionality may not be available. 

 

To view another user’s Inbox, complete the following tasks: 

Click the Proxy tab in the Inbox Summary. 

From the Proxy list, select the Inbox you would like to see. 

If necessary, specify a date range.  

The selected user’s Inbox opens, allowing you to work in the proxy’s Inbox as if it were 
your own.  Note that the tasks that you can perform can be limited by your Systems 
Administrator or by the user’s Inbox you are proxying.  

Note:  In order to view another user’s Inbox, you must have proxy rights.  You can either have the 
user grant you access to their Inbox or you can make yourself a proxy.  

Read Only Inbox 

Note: Read Only Inbox is available with the 2007.18 Release Update. 

If enabled, users have the ability to view items within an individual inbox or pool in a read 
only mode within the list view. These items cannot be opened or acted upon outside of 
the Select Patient function in this read only mode. 

Note: The ability to open another user or pool’s Message Center in read only mode for the session 
is enabled through a preference that creates the Select Read Only Inbox menu option. 

 

Out of Office 
Note: Out of Office functionality is available with Cerner Millennium® Cumulative Support Package 

2007.17 and future Cerner Millennium® Cumulative Production Packages. 

Out of Office functionality provides the ability to set an Out of Office status on an 
individual or pool inbox. 
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The Out of Office status is set under the Inbox menu for an individual or pool inbox. An 
optional until date can be entered. 

When sending to users or pools with the status set, the sender receives an Out of Office 
notification with the date displayed (if entered). The sender has the option to send anyway 
or discontinue the send.  

Note: The date entered in the dialog does not automatically turn off Out of Office when the date is 
reached. It continues to return until the Out of Office status is removed by the recipient 
inbox. Also, IQHealth consumers receive a message back in their inbox with the Provider’s 
Out of Office notification information.  

 
 

 
 

 
 
 

Opening an Inbox Item 
To open an Inbox item, complete the following tasks: 

In the Inbox Summary, double click an Inbox folder, for example, Results. 

Double-click a notification type (for example, Abnormal).  A list of notifications from that 
category is displayed in the Message Center workspace. 

Double-click a notification in the notification list to display details of the notification.  

Note:  You can select multiple notifications in the notification list by selecting the first one, 
pressing SHIFT, and selecting the last one.  You can open selected notifications by 
selecting a single notification and holding the CTRL down as you select others. 

Creating a New Message 
To create a new message, complete the following steps: 



Message Center Solution Training Guide 

 
 

Revision:  001 
September 3, 2008 

Doc ID:  A1001001A07L06B40255G64812 
2008 Cerner Corporation.  All rights reserved.  This document contains 

confidential information, which may not be reproduced or transmitted without the 
express written consent of Cerner. 

Page 10 of 38 
Owner:  Methods 

 

Click  and select Message. 

Enter the patient’s last name in the Patient box and click .  The Person Search window 
opens. 

Select the patient or encounter and click OK. 

The patient’s name will automatically be entered in the Caller box.  If the caller is not the 
patient, enter their name and phone number in the Caller and Caller # fields. 

Enter the recipient(s) in the To and CC boxes by entering the first few letters of their last 

name and clicking  or ENTER.  To include yourself, select Include Me.  If the 
patient has an IQHealth account, select To Consumer to forward a copy of the 
message to them.  

Note: You can also select a recipient by double-clicking a name from your Personal Address List.  
For information on adding recipients to your Personal Address List, click here.  

Enter or select a subject and compose the message.  If saving the message to the chart, 
select the appropriate document type. 

If necessary, set a reminder or due date for the message. 

Select any additional messaging options.  

When you have completed the message, click Send. 

Note:  You can also create a message regarding any notification by right-clicking on the 
notification and selecting Communicate > Message. 

Signing or Reviewing Documents and 
Results 

Documents and results that require your review or signature are displayed in the Inbox 
Summary.  Notifications that require your signature include results from orders you 
placed, transcribed documents, saved documents, as well as documents and results 
forwarded to you by another provider. 

To sign or review a notification, complete the following steps: 

Open and read the message. 

Review the notification and select Sign or Endorse.  

Note:  Documents can be modified prior to signature 

Click OK or OK & Next. 
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Replying to a Message 
To reply to a message, complete the following steps:  

Open and read the message. 

Click either Reply to reply to only the sender or Reply All to reply to the sender and all 
recipients of the message. 

Compose the message. 

Select any additional messaging options.  

Click Send. 

Forwarding Messages 
With the message open, click Forward.  

Click  next to the To box. 

Select a recipient and click OK. 

Compose the message. 

If you would like to save a copy of the message to the patient’s chart, click Save to Chart 
and select an option from the As list. 

Select any additional messaging options.  

Click Send. 

Note:  You can also forward a message directly from the list of messages displayed in the 
Message Center workspace without opening it by selecting the message in the notification 
list and clicking Forward. 

Deleting Messages 
Messages can be deleted in one of two ways: 

• Select the message you want to delete from the message list in the Message Center 

workspace and click .  

• With the message open, click .  

Note:  Deleted messages are sent to the Messaging Trash folder and can be recovered until the 
Messaging Trash folder is emptied. 



Message Center Solution Training Guide 

 
 

Revision:  001 
September 3, 2008 

Doc ID:  A1001001A07L06B40255G64812 
2008 Cerner Corporation.  All rights reserved.  This document contains 

confidential information, which may not be reproduced or transmitted without the 
express written consent of Cerner. 

Page 12 of 38 
Owner:  Methods 

 

Restoring Deleted Messages 
To restore deleted messages, complete the following steps: 

Double-click the Messaging Trash folder in the Inbox Summary. 

Select the message(s) you want to restore. 

Click . The message is moved from the Messaging Trash folder to its original folder. 

Emptying the Messaging Trash Folder 
Messages that you deleted are stored in the Messaging Trash folder until you empty it.  
Once you have emptied the Messaging Trash, you can no longer restore deleted 
messages.  

To empty the Messaging Trash Folder, complete the following steps: 

Click the Messaging Trash Folder icon in the Inbox Summary.  

Click .  

Printing a Message 
Messages can be printed in one of two ways 

• Select the message you want to print from the message list, right-click, and select 
Print. 

• With the message open, click . 

Additional Options when Creating a Message 
The following options are available when creating a new message: 

Save to Chart:  Saves a copy of the message to the patients chart. 

As:  Allows you to select how the message is saved to the patient’s chart, for example, as 
a Pharmacy Note. 

Include Me:  Forwards a copy of the message to your Inbox. 

To Consumer:  Forwards a copy of the message to the consumer.  This option is only 
available if the patient subscribes to IQHealth. 

Actions:  Allows you to select a follow-up action. 
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Remind On:  Allows you to set a reminder date/time.  The message appears in italics 
when the remind date/time is reached. 

Due On:  Allows you to set a due date for the message.  Messages with past their due 
date are indicated in red and moved to the Priority folder. 

Urgency:  Clicking  marks the message as urgent. 

Message Journal:  Clicking  opens the Message Journal, allowing view all Inbox 
messages recorded for this patient.  

Notify:  Allows you to request a notify receipt to be generated when a message is 
overdue or opened. 

Working with the Message Journal 
The Message Journal function of Cerner Millennium allows you to review all Inbox 
messages for a selected patient.  This feature allows you to quickly establish a history of 
all communication surrounding the patient.   

Viewing the Message Journal for a Patient 
To view messages using the Message Journal, complete the following steps. 

With any Inbox folder open, click .  The Patient Search window opens. 

Search for and select the patient whose Message Journal you would like to see.  

Click OK.  The Message Journal dialog box opens.  

If necessary, filter the messages that are displayed by selecting the message type from 
the Type list or enter dates in the To and From boxes.  

Click the message you would like to read. 

When you have finished reviewing Message Journal, click OK.  The dialog box closes, 
returning you to the Inbox window. 

Working with Documents  
The Documents to Sign Folder contains documents you have saved, transcription 
documents awaiting your signature, reports, as well as results or documents forwarded to 
you for signature from another clinician.  Documents in this folder may have been created 
in Cerner Millennium or a third-party software application 
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Viewing a Document 
Complete the following steps to view a result: 

Navigate to the Documents section in the Inbox Summary. 

Double-click a document or select the document and click Open. 

View the document. 

Sign, refuse, forward or forward the document to another provider for review without 
signing or refusing it. 

 Editing the Document 
To edit this document: 

Right click in the text window, and then left click on the “Modify” option. 

 

A new window will open up. In this window you will be able to edit the document. 

 

Once you have completed your edits, then left click on the “Save & Close” button 

 on the lower right. 
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Signing a Document 
To Sign individual documents in the Documents to Sign folder, complete the following 
tasks: 

Navigate to Documents to Sign folder in the Inbox Summary. 

Double-click a document or, or select it and click Open. 

Review the document. 

Select Sign. 

Enter any comments. 

Click OK or OK & Next.  

Signing and Forwarding Documents 
PowerChart allows you to sign a document and then forward it on to another clinician in 
one action.  To forward a document after signing it, complete the following tasks: 

Open the Document.  

Review the content. 

In the Action pane, select Sign. 

Select an option from the Additional Forward Action list. 

Select any recipient(s) from the To: list. 

Enter any comments. 

Click OK or OK & Next. 

Forwarding a Document without Signing or 
Refusing It (Forward Only) 

Cerner Millennium allows you to forward a document to another clinician without signing 
or refusing the document.  For example, if you are a medical student or nurse, you could 
forward a document to a physician for their review and signature.  To forward a document 
without signing it, complete the following steps: 

1.  Open the Document.  

Review the content and click Forward only. 

Select an option from the Additional Forward Action list. 
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Select any recipient(s) from the To: list. 

Enter any comments. 

Click OK. 

Refusing a Document 
To refuse a document, complete the following steps: 

Open the Document.  

Review the document and select Refuse. 

Select a reason for refusal. 

Left click in the yellow field next to “Additional Forward Action” 

Select the “Review” option. 

Left click on the yellow field beside "To:" 

Type himr and hit the "enter" key on the keyboard. "Himrefusal, Inbox" should now 
be displayed. 

Enter any comments. 

Click OK or OK & Next.  

Marking a Document as Reviewed 
To mark a document as reviewed, complete the following steps: 

Open the Document.  

Review the document and select Review. 

Enter any comments. 

Click OK or OK & Next.  

Reviewing and Forwarding Documents 
To mark a document as reviewed, complete the following steps: 

Open the Document.  

Review the document and select Review. 

Select an option from the Additional Forward Action list. 



Message Center Solution Training Guide 

 
 

Revision:  001 
September 3, 2008 

Doc ID:  A1001001A07L06B40255G64812 
2008 Cerner Corporation.  All rights reserved.  This document contains 

confidential information, which may not be reproduced or transmitted without the 
express written consent of Cerner. 

Page 17 of 38 
Owner:  Methods 

 

Select any recipients from the To: box. 

Enter any comments. 

Click OK or OK & Next.  

Address Books 

Using Address Books 
Use the Global and Personal Address Books to look up recipients when sending and 
forwarding notifications.  To select a recipient, complete the following steps: 

When composing a new message or forwarding an existing message, type the first few 

letters of the recipient’s name in the To: or CC: box and click  

In the Show Names From list, select Personal Address Book or Global Address Book.  

Note:  For more information on adding names to your Personal Address Book, click here.  

To locate the name you want, enter a portion of the last name in the Type Name or Select 
From List box. 

Select the person you want. 

Click >.  The name is moved to the Send To list. 

Repeat Steps 3 and 4 until you have added all the recipients' names. 

Click OK to add the recipients to the message. 

Adding Names to Your Personal Address 
Book 

Your Personal Address Book enables you to maintain a list of people in your organization 
with whom you correspond frequently.   

To add names to your Personal Address Book, complete the following steps: 

When composing a new message or forwarding an existing message, type the first few 

letters of the recipient’s name in the To: or CC: box and click . 

In the Show Names From list, select Global Address Book.  

To locate the name you want, enter a portion of the last name in the Type Name or Select 
From List box. 

Select the person you want. 
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Right-click the name you want to add and select Add to Personal Address Book. 

Removing Names from Your Personal 
Address Book 

To remove names from your Personal Address Book, complete the following steps: 

With the New Message window open, click . 

In the Personal Address List pane, right-click the name you want to remove and select 
Remove from Personal Address Book.  

Proxy Authorization 
Granting proxy authorization enables another provider to access your Inbox and work with 
it as your proxy.  Additionally, you may be able to take proxy from another provider and 
access their Inbox as their proxy. 

Your proxy can perform any activities for which you have granted them authorization, 
such as signing, refusing and forwarding messages and results.  When granting proxy 
authorization, you specify the provider, the specific Inbox folder(s) to which you wish to 
give proxy as well as the effective dates for the proxy. 

As a proxy to another user’s Inbox you have access to the folders and functions that have 
been granted to you.  The proxy Inbox has the same look and feel as your Inbox, except 
that all actions that you take are on behalf of the individual for which you are proxy.  Note 
that any activities that you perform as a proxy are logged. 

Viewing Messages as a Proxy 
To access an Inbox to which you have proxy, complete the following tasks: 

Click the Proxies tab in the Inbox Summary. 

From the Proxy list, select the name of the user’s Inbox you want to work with. The folders 
to which you have been given proxy authorization are displayed in the Inbox 
Summary.  At this point, you are able to complete all of the tasks for which you have 
proxy rights.   

Note: If you sign an Inbox item as a proxy, the signature will state you have signed on behalf of 
the individual’s Inbox you have proxied.  If you review an item and want to leave it for the 
original provider to review as well, close the notification or move to the next Inbox item.  Do 
not sign, refuse, or forward the notification. 

When you are finished working in the proxy Inbox.  Click the Inbox tab in the Inbox 
Summary. Your Inbox folders are displayed. 
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Viewing Proxy Authorizations Granted to 
You 

 

To view a list of all providers and document types for which you have been granted proxy 
authorization, complete the following steps: 

From the Inbox menu, select Manage Proxy. 

Click the Received tab. 

The users displayed in the Proxies Received by Me pane are authorizations that have 
been granted to you. 

To view detailed information about the privileges granted by a particular user, select user 
and click Details.  

Viewing Proxy Authorizations that you have 
granted  

 

To view a list of all individuals to which you have granted proxy authorization, as well as 
specific permissions of each authorization, complete the following steps: 

From the Inbox menu, select Manage Proxy and click the Manage Proxy tab. 
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All proxies that you have granted are listed in the Proxies Given By Me pane. 

Select the proxy that you would like to view and click Details.  The specific permissions 
that you have granted are displayed.  

Granting Proxy Authorization 
Granting proxy authorization to another provider or provider group enables the proxy to 
perform any activities for which you have granted them authorization, such as signing, 
refusing and forwarding messages and results.   

 

To grant proxy authorization to another provider, complete the following steps: 

From the Inbox menu, select Manage Proxy and click the Manage Proxy tab. 

Click Add. 

From the User list select the user that you want to give proxy to. 

 To grant proxy to more than one user use the arrow to move the current user to the 
additional user's box and continue searching. 

Specify a Start Date/Time and End Date/Time.  For example, if you will be out of the 
office for two weeks, specifying the Start Date/Time and End Date/Time ensures the 
proxy will be able to access your Inbox messages during that period only. 

To grant all permissions to the selected user, click the Grant All.  To grant selected 
permissions to the proxy, select the permission and click Grant. 

Click OK.  
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Updating Proxy Authorization 
Once you have granted proxy authorization, you can update the proxy as necessary. 
Complete the following steps to update a proxy that has been previously configured. 

From the Inbox menu, select Manage Proxy and click the Manage Proxy tab. 

From the Proxy list, select the proxy you want to update and click Details. 

Modify the proxy as needed.  For information on the options that can be configured, click 
here. 

Click Accept and Next and OK. 

Taking Proxy Authorization 
Taking or “stealing” proxy authorization from another provider enables you to review, sign, 
refuse, and forward messages for them.   

Note:  Depending on how your system has been configured, you may or may not be able 
complete this task. 

 

From the Inbox menu, select Manage Proxy. 

Click the Received Tab. 

In the Proxies Stolen By Me pane, click Add. 

From the User list select the user that you want to take proxy from. 
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Select additional users from the Additional Users box. 

Specify a Start Date/Time and End Date/Time for the proxy. 

To take all permissions to the selected user, click the Grant All.  To grant selected 
permissions to the proxy, select the permission and click Grant. 

Click OK. 

Note:  While you can take proxy from another provider at any time, the system records any 
activity you perform and the provider from whom you have taken proxy is notified that you 
have taken proxy from them.  

Viewing Proxies Taken By another User 
The system logs every time another provider takes proxy to your Inbox.  To view all users 
that have taken proxy, complete the following steps: 

From the Inbox menu, select Manage Proxy. 

Click the Given Tab. 

The Proxies Stolen from Me pane displays the users that have taken or “stolen" proxy to 
your Inbox. 

To view the details of the stolen proxy, select the user and click Details.  

Note:  You can also set a preference on the General tab of the preference page that controls an 
indicator that displays when proxy has been stolen from you. 

Changing Proxy Start and End Times 
Once you have granted proxy authorization, you can update the effective dates and times 
as necessary.  Complete the following steps to change start and end times for a proxy 
that as been previously configured: 

From the Inbox menu, select Manage Proxy and click the Manage Proxy tab. 

From the Proxy list, select the authorization you want to update and click Details. 

Modify the Start Date/Time and End Date/Time.  For example, if you will be out of the 
office for two weeks, specifying the Start Date/Time and End Date/Time ensures the 
proxy will be able to access your Message Center messages during that period only. 

Click Accept and Next and OK.  

Removing Proxy Authorizations that have 
been Taken or Granted 

To remove an existing proxy authorization, complete the following steps: 
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From the Inbox menu, select Manage Proxy and click the Manage Proxy tab. 

All proxies that you have granted are listed in the Proxies Given By Me pane.  Proxies that 
have been taken are in the Proxies stolen by me pane  

Select a proxy. 

Click Remove.  The proxy authorizations are removed 

Click OK. 

 

Pools 
A pool is a shared mailbox that can be accessed by any user that is a member of the 
pool.  However, while the contents of the Inbox are visible to all members of the pool, only 
one individual must act on an item in order for that item to be considered complete.  Pool 
functionality allows providers that work in a care team setting to share responsibility for 
managing results, documents, and messages for a shared group of patients.  

Working with Messages as a Member of a 
Pool 

To access a pool Inbox, complete the following tasks: 

In the Inbox Summary, click the Pools tab. 

Select the pool that you would like to access from the Pool list. 

If necessary, click the Manage button to access pools not displayed in the Pool list. 

Note:  Specific permissions are necessary to access this functionality.  If you are not able to 
manage pools, contact your pool administrator. 

Select a specific date range. 

If necessary, narrow the number of messages displayed by selecting an option from the 
Filter list. 

Click the plus (+) sign next to the category to expand it; Click the minus (-) sign next to the 
category to collapse it.  Click a folder to display the items in that category. 

Double-click the item or select it and click Open to view the item. 

To assign or unassign an item to yourself, right-click the item and select the appropriate 
assignment option. 
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Managing Pools 
Depending on your site’s configuration, you may be able to opt in or out of a pool as well 
as perform additional pool configuration tasks using the steps outlined below.  If you 
cannot complete the tasks outlined below, contact your Pool or System Administrator for 
assistance.  

 

To complete any of the following tasks, select Manage Pools from the Inbox menu.  The 
Pools Setup window is displayed. 

• To add you to a pool, select the pool from the Available Pools pane and click Opt In. 

• To remove you from a pool, select the pool from the Member Pools pane and click 
Opt Out. 

• To modify the preferences of a pool you are a member of, select a pool in the 
Available Pools pane, click Details and modify any parameters necessary.  When you 
have completed any modifications, click OK to save changes. 

• To remove a pool, select a pool Available Pools pane and click Remove. 

Creating a New Pool 
To create a new pool, complete the following tasks: 

Note:  Creating new pools usually requires you to be a Pool Administrator.   
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Select Manage Pools from the Inbox menu.  The Pool Setup window is displayed. 

In the Available Pools pane, click Add. 

Enter a name and description for the new pool. 

Build the pool by selecting members from the Members or Organizations lists and clicking 
Add. 

Add additional members to the pool by entering the first few letters of the user’s name in 

the Search for Member list and clicking . 

If applicable, select any options from the Member Options pane. 

To designate a Team Lead for the pool, select user from the Members list and click Make 
Team Lead. 

Click Apply and OK. 

Notifications and Reminders 

Overview of Reminders and Notifications 
The Reminder feature of Cerner Millennium allows you to compose messages or 
designate results or documents for follow-up at a later time.  They are intended as 
“ticklers” to ensure that patient care activities for the specified patient are carried out at a 
later time.  Reminders can either be sent to another user’s Inbox or attached to a patient’s 
chart.  

Reminders that are sent to another user’s Inbox are similar to messages except that they 
are saved to the recipient’s Reminders folder and do not appear until the designated show 
up date.  Reminders that are sent to a patient’s chart appear in the Overview section of 
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the chart and are intended as an alert or reference for the clinician reviewing the chart at 
a later date.  Reminders can also be generated from a result dialog and will include the 
selected discrete results. 

Notifications can be attached any Messages, Reminders, Consults or Sent Items where 
notification of receipt or action is required.  When you attach a notification with a message 
you are alerted when the recipient opens the message or does not open the message by 
the due date.  Notifications work in conjunction with Reminders and Due Dates and can 
be configured to alert either the sender or another recipient.   

Creating a New Reminder 
Reminders are intended as “ticklers” to ensure that patient care activities for a specified 
patient are carried out at a later time.  

Click  and select Reminder. 

Enter the patient’s last name in the Patient box and click .  The Person Search 
window opens. 

Select the patient and click OK. 

Select an option from the Show In list.  Selecting the Recipient’s Inbox option sends the 
reminder to the recipient(s) designated in the To: and CC: boxes; Selecting Chart 
sends the reminder to the selected patient’s overview section of the chart. 

If sending the reminder to another user, enter the recipient(s) in the To: and CC: boxes by 

entering the first few letters of their last name and clicking  

Note: You can also select a recipient by double-clicking a name from your Personal Address List.  
For information on adding recipients to your Personal Address List, click here.  

Enter or select a subject and compose the message of the reminder. 

Enter the Show Up and/or Due On time for the reminder. 

Select any additional messaging options.  

Click Send. 

Working with Reminders 
Reminders can be acted on directly from the summary list or by opening and reviewing 
them. 

Click the Reminders folder in the Inbox Summary. 

Open the reminder by double-clicking the reminder in the Reminders workspace. 
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Review the reminder and mark it as complete.  You can also redirect, reschedule the 
reminder, or reply to it. 

You can also act the reminder directly from the summary list by selecting the reminder 
and performing one of the actions outlined in step 3. 

Setting a New Notification 
When you attach a notification with a message you are alerted when the recipient opens 
the message or does not open the message by the due date.  Notifications work in 
conjunction with Reminders and Due Dates and can be configured to alert either the 
sender or another recipient.  

To set a notification, complete the following tasks: 

Click  when composing a message.  The Notify dialog box opens. 

Select either the Opened by the recipient, Completed by the recipient, or Due and Not 
Opened/Completed notification option. 

Note:  If Due and Not Opened is selected, a Due Date must be set. 

If you would like to receive a notification, select Me.  You can also choose to have an 
additional individual receive a notification by browsing for their name. 

Select a Notification Priority. 

Click OK. 

Redirecting a Reminder 
Reminders that you receive can be acted on, rescheduled or redirected to another user.  
To redirect a reminder, complete the following steps: 

Open and review the reminder. 

Click . The Redirect dialog box opens. 

Enter the first few letters of the recipient’s name in the To: box. 

Enter a Show Up or Due On time. 

Click OK.  The reminder is removed from the Inbox and redirected to the designated 
recipient. 

Note:   Reminders can be redirected without opening them.  To redirect a reminder, select the 
reminder from the summary list, click Redirect and follow steps 3 to 5. 
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Rescheduling a Reminder 
Reminders that you receive can be acted on, redirected to another user or rescheduled. 
To reschedule a reminder, complete the following steps: 

Open and review the reminder. 

Click . The Reschedule dialog box opens. 

Enter a new Show Up or Due on time. 

Click OK.  The reminder will be removed from the Inbox and will reappear on the new 
Show Up date/time. 

Note:   Reminders can be rescheduled without opening them.  To reschedule a reminder, select 
the reminder from the summary list, click Reschedule and follow steps 3 to 5. 

Reminder Options 
When setting a reminder, two options can be set: 

Show Up:  The Show Up date sets the date when the reminder appears in the recipient’s 
Inbox or becomes active if the reminder is attached to a patient chart. 

Due On:  The Due On date sets the due date for the reminder.  Reminders that are 
overdue are indicated in red and displayed in the Priority folder. 

A reminder’s Show Up on and Due On dates can be set in one of two ways: 

By number of days/months/of years:   

• Enter an interval.  For example, 3 days.  The system calculates the Show Up or Due 
On date. 

By date: 

• Enter a Show Up or Due On date.  The system calculates interval. 

Generating Quick Reminders from Results 
A Quick Reminder can be generated from any result in the Inbox.  To generate a Quick 
Reminder from a result, complete the following steps: 

Open the result. 

Select Endorse or Forward Only. 

Select a quick reminder option from the Additional Forward Action field. 

Select a recipient or recipients from the To: list. 
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If needed, change the due date and/or time. 

Enter any comments. 

Click OK or OK & Next. 

Customizing Message Center 

Filtering Inbox Items by Time Interval 
You can configure the Message Center to display only items received during a specific 
time interval.  For example, you can choose to display only Inbox items that were received 
in the last 10 days. 

You can filter notifications based on date in one of two ways: 

• Select a predefined date range from the Display list in the Inbox Summary. 

• In the Inbox Summary, click the ellipsis, enter start and finish dates and click OK. 

Note:  To set the default date, select Manage Preferences from the Inbox menu.  This and all 
other general preferences are set in the General section.  

Setting Folder Order in the Inbox Summary 
You can set the order of folders and sections as they appear in the Inbox Summary by 
clicking and dragging the folder or section header.  Any changes you make will be saved 
when you exit Cerner Millennium. 

Defining Notification Types 
To define which notification types, such as Results and Documents, are displayed in the 
Inbox Summary folders, complete the following steps: 

From the Inbox menu, select Manage Configuration.  The Setup dialog box opens. 

In the Summary View pane, select the notification types you want displayed. 

Note:  Some notification types have further options that can be set in the Category pane. 

When you have completed selecting notification types, click OK. 

Setting the Default Phone Message Template 
You can specify which phone message template you want as the default for new phone 
messages, as well as the default document type to be used when the system cannot 
determine the document type.  To specify your default phone message template or 
document type, complete the following steps: 
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From the Inbox menu, select Manage Preferences.  The Setup dialog box opens. 

Click the Behavior Prefs tab and select Message. 

Select a document type or template from the Defaults when Creating a New Message list.  
This default document type will be used when the system cannot determine the 
document type from the subject of the message. 

From the Template list, select the template you want.  This will be your default subject. 

Click OK.  

Troubleshooting and Technical 
Support  

 Using Technical Support 
Some Cerner solutions now provide live technical assistance through the solution.  To 
access this feature, select Live Chat Assistance from the Help menu and choose either 
Live Chat with a Support Representative or Have a Support Representative Call Me.  

If you select Have a Support Representative Call Me, enter your phone number in the box 
and click OK.  A support representative will contact you.  

If you select Live Chat with a Support Representative, wait until you are connected to a 
support representative, and then ask your question. 

Things to note before contacting Cerner Technical Support 

• The details of what happened just before the error occurred. 

• Any information that you may have entered. 

• The date and time the error occurred. 

• If you receive an Illegal Operation... error, click Details and then take a screen shot 
(pressing ALT+PRINT SCREEN is one method) of the information. 

Basic Troubleshooting 
The system messages listed below could be displayed.  For more information about a 
system message, click the message.  The information displayed contains an explanation 
of the message and the action you should take to correct the issue. 

If appropriate, a more technical description also is provided for use by your system 
administrator.  If the technical description mentions contacting Cerner to correct the 
problem, it will be very helpful if you provide the following information to your system 
administrator: 
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The messages shown below are sorted first by numbers, if the message includes one; 
then by symbols, such as brackets ([ ]), which enclose message text that is variable; and 
finally, alphabetically, by the message text itself.  

Error Messages 
Encounter creation has been cancelled and will not be used for 
ordering. 

Explanation:  This message is displayed if your site has chosen to automatically create 
encounters when phone messages are generated and you have attempted to cancel a 
medication order.   

When the RX/Meds button is clicked, an encounter is created.  If the order is cancelled, 
the encounter that the medication order is placed on may be different from the phone 
message encounter. 

Action: If you would like the encounter for the ordering to be the same as the phone 
messaging encounter, click OK to the message, cancel out of PowerOrders, and select 
Rx/Meds to re-enter.  If this is not needed, click OK to continue. 

All Results must be viewed before they can be endorsed or signed.  
Please view all results and try again. 

Explanation: You are attempting to endorse a patient’s result without viewing all 
associated results. 

Action: Scroll down to view all the results before selecting OK or OK & Next.  

You have orders that are awaiting signature.  Do you want to 
withdraw the proposed orders? 

Explanation: You are attempting to cancel a message that contains proposed orders. 

Action: Select Withdraw to withdraw the proposed orders.  Select Ignore to cancel the 
message without withdrawing the proposed orders.   

You attempted to switch templates. 

You attempted to switch templates.  To append the changes to the new template, click 
Append.  To change templates without saving your changes, click Replace.  To return to 
the original template, click Cancel. 

Explanation:  After making changes (such as selecting a recipient or patient, or entering 
message text) to the original message, you selected a different option from the Subject 
list.  Selecting a different subject changes the message template. 

Action:  If you want to append the changes you made in the original message to the new 
message, click Append.  To change templates and delete your changes, click Replace.  
To return to the original template, click Cancel.  
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Communication is patient related.  Do you want to save it to the 
patient's chart? 

Explanation:  You are attempting to send a phone message on which you selected a 
patient, and did not select the Save to Patient’s Chart option. 

Action:  Click Yes to save the message to the patient’s chart.  Click No if you do not want 
the message saved to the patient’s chart. 

Due On Date must be after Remind On date.  Due On must be after 
Show On date. 

Explanation: You are attempting to set the due date and time for a message, reminder, 
or consult that is prior the date and time of the show up or remind date. 

Action: Set the due date to be after the Remind On or Show Up date. 

Appendix 

Windows 

Inbox Summary Window 

The Inbox Summary provides you with a quick view of all of the items in your Inbox.  View 
messages from the following sources by clicking the appropriate tab at the top of the 
Inbox Summary: 

• Inbox:  Your own Inbox  

• Proxies:  Inboxes for which you have proxy rights 

• Pools:  Pool Inboxes 

Regardless of whether you are viewing your Inbox, an Inbox you are proxy to or a Pool 
Inbox, the Inbox Summary allows you to view all notifications from that category in four 
categories.  A number next to each category or folder in the category indicates the 
number of unread notifications in that category or folder.  If the folder is not shown, no 
notifications are present for that category. 

• Priority Items:  If configured, includes any due messages, reminders, or consults. 

• Inbox Items:  Includes such items as Results, Documents, Messages and Orders.   

• Work Items: Includes Saved Documents, Documents to Dictate, Paper-Based 
Documents, Reminders, Consult Orders and Reminders as well as Incomplete 
Orders 

• Notifications:  Includes notification receipts for messaging as well as the Trash and 
Sent Items folders. 



Message Center Solution Training Guide 

 
 

Revision:  001 
September 3, 2008 

Doc ID:  A1001001A07L06B40255G64812 
2008 Cerner Corporation.  All rights reserved.  This document contains 

confidential information, which may not be reproduced or transmitted without the 
express written consent of Cerner. 

Page 33 of 38 
Owner:  Methods 

 

Toolbar Buttons 
Note:  The following list of Toolbar buttons is inclusive of all buttons that could be displayed in the 

Inbox workspace.  Buttons that are displayed may change based on the Message Center 
component you are accessing. 

The Message Center toolbar contains the following buttons:  

Button Action 

  
Communicate. Creates a new message, reminder or 
consult. 

  
Open. Opens the selected notification. 

  
Message Journal.   Displays a list of all phone messages, 
reminders, and consults that have been documented for 
the selected patient. 

  
Reply Opens the item, enabling you to send a reply to the 
sender.   

Note: Replying to reminders will create a new phone message. 

 
Reply All. Opens the item, enabling you to send a reply to 
the sender and all recipients of the original item. 

  
Complete.  Marks the selected item as completed. 

 
Forward. Opens the item, enabling you to add text and 
forward the item to another user. 

  
Delete. Deletes selected item. 

 
Select Patient. Displays only results, messages and other 
Inbox items particular to the selected patient. 

 
Select All. Displays all results, messages and other 
notifications.  

  
Send to Consumer. Forwards the result to the patient via 
IQHealth. This option is only available if the patient 
subscribes to IQHealth. (Results Only) 

  
Print. Prints the selected notification. 

 
Up Arrow. Opens the previous notification. 

 
Down Arrow. Opens the next notification.  
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Send Reminder. Allows you to send a reminder to another 
individual pertaining to the result. (Results Only).   

 
Forward Only. Forwards the selected result without 
signing. 

  
Reschedule. Allows you to reschedule a Reminder to 
reappear within the Inbox on a new date and time (Work 
Items Only) 

  
Redirect. Allows you to redirect the reminder or consult to 
another recipient. (Consult and Work Items Only) 

 
Modify Order Details. Used with medical student or 
incomplete orders.  Allows you to modify order details 
within PowerOrders before signing. 

  
Restore. Allows you to move an item from the trash into 
the appropriate item folder. 

  
Empty Trash Deletes all messages, reminders, and 
consults in the Messaging Trash folder. 

Formatting Toolbar 

The following formatting buttons are available when working with messages: 

Button Action 

 
Font Color. Changes the color of the selected text. 

 
Cut.  Cuts the selected text. 

 
Copy.  Copies the selected text. 

 
Paste.  Pastes the selected text. 

 
Bold.  Bolds the selected text. 

 
Italic.  Italicizes the selected text. 

 
Align Left.  Makes the selected text left justified. 

 
Align Right.  Makes the selected text right justified. 

 
Center. Centers the selected text. 
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Spell Check.  Checks all spelling in the text box. 

 
Manage Autotext.  Allows for the creation of new autotext. 

 
Insert Template.  Allows for the insertion of a pre-defined 
template into the message. 

 

Menus 
Task Menu 

The Task menu contains the following commands: 

Command  Action 

Change Password Enables you to change your password.  Passwords may be of 
any length and contain any alphanumeric characters.   

Change User Opens the log-on dialog box so a new user can log on to the 
system.  This menu command is available if the appropriate 
preference is set for your position.  

Suspend Pauses, but does not exit the application after prompting the 
current user to save any changes.  Displays the log on dialog 
box so you must enter a password to resume processing.  
Suspending the application is recommended whenever you step 
away from your workstation to prevent unauthorized access to 
sensitive information  

Reports Opens the Reports dialog box where you can select one or 
more types of reports to be generated for the selected patient.  
When you designate a printer, the report is printed according to 
a predefined template and format.  

Print  

MRP Print Prints the patient’s entire chart. 

Print Opens the Print dialog box to allow you to print the active 
screen or elements associated with the current screen. 

Print Screen Prints the current window. 

Refresh Refreshes the screen. 

Exit Closes the current application.  If you have not saved your 
changes, you are prompted to do so. 
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Edit Menu 

The Edit menu contains the following commands: 

Command Action 

Cut Cuts a selected object, such as text or a file, so it can be 
inserted elsewhere.  To cut, highlight the object you want to cut 
and select Cut from the Edit menu. 

Copy Copies a selected object, such as text or a file.  To copy, 
highlight the object you want to copy and select Copy from the 
Edit menu.  

Paste Inserts a cut or copied object, such as text or a file.  To paste, 
place the cursor where you want to paste the cut or copied 
object and select Paste from the Edit menu. 

Delete Deletes a selected object, such as text or a file.  To delete, 
select the object you want to delete and select Delete from the 
Edit menu.  

Help Menu 

The Help menu contains the following commands: 

Command Action 

[Application] Help Opens the Help module particular to the active Cerner 
Millennium component. 

Navigation Opens Cerner Millennium Enhanced View Help. 

HNA Help Topics Opens Cerner Millennium Help. 

Policy & Procedures Opens your site-specific policy and procedure information. 

Live Chat Assistance Enables you to open a chat session with a support 
representative or have a representative contact you. 

About PowerChart Displays copyright and version information. 

View Menu 

The View menu contains the following commands: 

Command  Action 

Patient List     Opens the Patient List. 

Home     Opens the Home View. 
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Message Center    Opens the Message Center. 

Scheduling     Opens the Patient Scheduler. 

[Solution Name]    Opens the selected Cerner Millennium solution. 

Toolbar Navigation Toolbar  

Links Toolbar  Toggles the Links toolbar.  A check mark next to this command 
indicates the toolbar is visible. 

Action Toolbar  Toggles the Action toolbar.  A check mark next to this command 
indicates the toolbar is visible. 

Notifications Toolbar  Toggles the Notifications toolbar. A check mark next to this 
command indicates the toolbar is visible. 

Patient Toolbar   Toggles the Patient toolbar.  A check mark next to this 
command indicates the toolbar is visible. 
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